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Introduction — Referral Specialist 
 
These training examples represent common tasks performed by NOIS Specialists who 
develop and maintain VistA software. For NOIS on Forum, this includes Technical 
Service programmers. For NOIS installed at a local site, the process of referring problems 
is less common; although, you may organize so that some problems are referred to IRM 
staff that handle specialized problems. 
 
As a NOIS Specialist you can edit calls. You can close and cancel any call, You can 
assign a support open status on calls requiring more background. You can also create 
batch edit, associate calls as duplicates, and create and edit web pages. You can use User 
Defaults (using List Manager to edit your defaults). You can also do anything a general 
user of NOIS can do (which is actually a whole bunch of stuff). If you need help with 
NOIS, contact a NOIS Coordinator. To see who is a NOIS Coordinator, use the NOIS 
menu on Forum for File Setup, enter SPEC and sort by NOIS Coordinator. 
 
The examples here all relate to using the GUI. The only things you can't do with the GUI 
are User Defaults, Define a List, and File Setup. 
 

Benefits 
 
The benefit of NOIS is that you can track and organize reported problems. You can also 
review previous problems to search for potential solutions. NOIS allows you to 
communicate by leaving notes on calls when it is more convenient or you are unable to 
contact the site or support specialists. This is also true for your customer. It provides 
additional information related to the request such as information on software, patches, 
installations, and contacts. It allows you to work in a geographically distributed team 
organization. Hopefully it provides a better product and better service to the customer. 
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Common Lists 
 
Look at the File menu, Most Recently Used menu; these are the last lists that you've 
used. If you haven't used the lists below, look them up. Use File menu, Select List to get 
the Select NOIS List form. Make sure Common is selected, and choose a list. You may 
have to enter a Specific entry. Experiment restricting your list entries. Notice how your 
Most Recently Used menu changes. 
 
Referred calls for a package: 
These lists are for referred calls for a package or module/version#. 

Package, Referred: : <package> 
Module/#, Referred: < module/version#> 
 

Lists by Referral Specialist: 
These lists are useful on calls where a referral specialist is assigned the call. You need to 
enter a specialist (usually yourself). 

Ref Specialist, Not Closed: <specialist> 
Ref Specialist: : <specialist> 
 

Lists by Subcomponent: 
These lists are useful on calls where the package has subcomponents to categorize the 
calls. You need to enter a subcomponent. 

Subcomponent, Referred: <subcomponent> 
Subcomponent: : <subcomponent> 
 

Lists by Package and Developing Office: 
These list are useful for looking at all calls for a package or all calls developed at an 
office (CIOFO). 

Module/#:< module/version#> 
Package: <package> 
Ciofo, Dev Open: <office> 
Ciofo, Dev Referred: <office> 
Ciofo, Dev: <office> 
 

Other lists: 
MRA: <person>   last alerts processed 
MRE: <person>   last edited calls 
Site: <location>   all calls from this site 
Site, Not Closed: <location>  all unresolved calls from this site 
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Editing Calls 
 
1. Edit a Call 

Select the call you want to edit. Use Edit menu, Edit Call to bring up the Edit Call 
form. Click on the notes tab. Browse to another call on the main form. Note that you 
get a warning that you are viewing a different call than the one you are editing. Copy 
some text from the call you are viewing and paste it as a note on the call you are 
editing (use your right mouse button, or simply drag and drop the text). Spell check 
the new entry (use the right mouse button). Save the call. 

 
2. Make a Note 

Select the call you want to edit. Use Edit menu, Make a Note to bring up the Make a 
Note form. Enter some text. Paste in a common response (use your right mouse 
button). Note: if you don't have any common responses defined — cancel the Make a 
Note form and use the Options menu, Define Responses to add a common response 
— then make a new note and paste your response. 

 
3. Edit Personal Fields 

Select the call you want to edit. Use Edit menu, Edit Personal Fields to bring up the 
Edit Personal Fields form (you can also Edit Call form). Make some entries and click 
the Save button 

 
4. Batch Edit some calls 

Use Edit menu, Batch Editor to bring up the Batch Editor form). Make some entries 
and click the Save button. You are now presented with the Apply Batch Edits form. 
Review the edit information you have made and select the calls you will apply the 
edits to. Click the Apply button to make the changes or click Cancel to go back to the 
Batch Editor. 

 
5. Associate a Call as a Duplicate 

Select the call you want to make a duplicate. Use Edit menu, Associate Call to bring 
up the Associate Call form. Select a call in the list that is the duplicate. If the call is 
not on the list, look up the call. Click the OK button to make the association. 

 
6. Use the Duplicate Editor 

Use Edit menu, Duplicate Editor to bring up the Duplicate Editor form. Experiment 
with using the buttons and right mouse clicks. Drag and drop calls onto other calls. 
Notice how the primary call changes. Only save changes if you are sure these calls 
are duplicates; otherwise, exit. 
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Reviewing Calls 
 
1. Select a list of calls (restrict it to 5 entries) 

Use File menu, Select List. Select a list. Under Restrictions, select Last # of calls 
and enter 5. Click OK 

 
2. Display all the calls in Detailed format 

Use Format menu, Change Format. Under View, select All calls in list. Under 
Styles, select Detailed. Click OK. 

 
3. Display all calls in Brief format 

Use Format menu, Change Format. Under View, select All calls in list. Under 
Styles, select Brief. Click OK. 

 
4. Display a Fields format on all calls for the fields Module and Location 

Use Format menu, Change Format. Under View, select All calls in list. Under 
Styles, select Fields. Clear the fields in display by clicking the << button. Select the 
field Module/Version and click the > button (you could also just double click). Select 
the field Location also. Click OK. 

 
5. Display a Table format on all calls using a selected format 

Use Format menu, Change Format. Under View, select All calls in list. Under 
Styles, select Table. Under Format, select Public and choose a format from the drop-
down list. Click OK. 

 
6. Display a Statistics format on all calls for Module and Location 

Use Format menu, Change Format. Under View, select All calls in list. Under 
Styles, select Statistics. Select fields (as described in #4). Click OK. 

 
7. Display the same Statistics format and collate by Module 

Use same instructions as #6, except also select Module/Version from the Collate by 
drop-down list. 

 
8. Save a personal format that has fields and use it to display all calls in a Fields 

format 
Use Format menu, Change Format. Under View, select All calls in list. Under 
Styles, select Table. Clear the fields in the display by clicking the << button. Select 
the fields you would frequently use. Order the fields using the v or ^ buttons. Click 
the Define button and type in a name for this format. Click the New button. Now, 
under Formats when select Personal, you can make this selection. Click OK 

 
9. Change back to a standard format 

Use Format menu, Standard Format. The display goes back to a detailed format on 
a single call. 

 
10. Sort calls on the list by site by clicking the list header 



 NOIS — Training Examples — Referral Specialist 5 

Department of Veterans Affairs — VistA — August 1998 

Click a title on the current list. The list is sorted by that category. Click it again. The 
list is sorted in reverse order. Click the first, untitled section — this is sorted by date 
received (the default). 

 
11. Sort the list by Site, Status, and Priority 

Use Tools menu, Sort List to bring up the Sort Call form. Select fields on how you 
want the list sorted. Click OK. 

 
12. Check the Other Information on the call 

Select the call on the list. Use View menu, Other Information menu and make 
various selections. The information appears in a lower pane on the display. You can 
size the display by dragging the horizontal border. Notice how the Print menu (under 
the File menu) changes with the selections. 
 

13. Look at the Graph format 
Select a list with multiple calls on it. Use Format menu, Graph to. bring up the 
graph display. Change the fields, change the style, change the options. Experiment. If 
you are on a bar chart, you can zoom the display by dragging from left to right to 
generate the window you want enlarged. To unzoom the graph, drag from right to left 
and upward, or make a new selection of field or style. When you are done looking at 
graphs, Use Format menu, Graph to toggle off the display. You can also select a call 
on the list; the display will return to a standard format. 
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Finding Calls 
 
1. Look up a call 

Use File menu, Select Call to bring up the Select NOIS Call form. If you know the 
last 5 numbers of the call (example: 50001), enter those and click the Submit button. 
You can then select the call from those found. If you know the entire call ID 
(example: SLC-0798-52604), enter it and click Submit. If you know the location 
abbreviation and approximate date the call was opened, enter the abbreviation - 
month and year (example: TUA-0798), then select from the list. Click OK for the 
selection. 

 
2. Add this call to your Temp list 

Use File menu, Save List As to bring up the Save NOIS Calls to a Storage List form. 
Note: if you don't have a personal storage list, you will be prompted to create one. If 
you have multiple storage lists you can select them from the drop-down list. Select 
Add calls to list and click OK. Look at your Most Recently Used lists under the File 
menu. 

 
3. Find text in the display 

Select a call. Select the display (the cursor must be in the text). Use Edit menu, Find 
to bring up the Find form. Type in the text you want to find (example: undefined). 
Click the Find Next button. To find more occurrences use the F3 button. 

 
4. Find text using Text Finder 

Use Tools menu, Text Finder to bring up the Text Finder form. Select Last number 
of calls and enter 500. Enter the text you want to find in the calls (example: 
undefined). Click OK. Examine some of the calls to make sure they contain the text. 

 
5. Use queries to find calls. Save the list 

Use File menu, Clear List to start fresh. Use Tools menu, Query to bring up the 
Query form. Enter in the Field box: Module and <enter>. Enter in the 
Module/Version box: TIU and <enter>. Click the And selection. Enter in the Field 
box: Location <enter> and in the Location box: West Palm Beach <enter>. Click OK. 
Use File menu, Save List As to save this list (use Replace this list with these calls) 
and click OK 

 
6. Use graphs to find the selections 

Use Format menu, Graph to turn on the graph display. Select Status from the Fields 
list. Select a Pie style. With your cursor over the closed calls, do a right click. Select 
the menu item: Select where Status = Closed. Notice your list has changed to only the 
closed calls. Refresh the list by selecting Refresh List from the File menu (or use F5). 
Select a call in the list to turn off the graph display. 
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7. Sort the list and use selected calls to find calls 
Click Status on the list header. Use Tools menu, Select from List and select the 
Selected Calls tab. Highlight (drag over) the closed calls. Click OK. You now have 
the closed calls. Refresh the list (F5). 

 
8. Use a query to select calls 

Use Tools menu, Select from List and select the Query tab. Type in Status <enter> 
in the Field box. Type in Closed <enter> in the Status box. Click OK. Same results. 
Refresh the list (F5). 

 
9. Select calls using the list of STATUS: CLOSED. Refresh the list 

Use Tools menu, Select from List and select the Lists tab. Type in Status <enter> in 
the List box. Type in Closed <enter> in the Status box. Click the Include List button 
(or <enter>). Click OK. Same results. Refresh the list (F5). 

 
10. Use graphs and select multiple Specialists 

Use Format menu, Graph to turn on the graph display. Select Specialist from the 
Fields list. Select a Pie style. With your cursor over a section of the pie, do a right 
click. Select the menu item: Add to multiples where Specialist = <somebody>. Click 
over another section, adding other specialists to your selections. You can review your 
selections using the View Multiples action. Now use Select Multiple Specialist. Your 
list is now only those selections. 

 
11. Find the calls on this list that you have automatic notification on 

Use Tools menu, Notifications to bring up the Notifications form. Select the Find 
tab. Select Only calls in the current list. Click OK. Refresh the list (F5) and repeat 
this except select a different user (example: Enter a specialist on a call that is in the 
list). 

 
12. Organize calls in your temp lists 

Select your list of recent alerts (File menu, Select List, select MRA:, and enter your 
name). Use Tools menu, List Organizer to bring up the List Organizer form. Click 
the right mouse button in the Storage Lists section. Select New List. Click on the list. 
Create a few more lists. Move calls between your current lists and your storage lists. 
Experiment. Use the right mouse button actions to rename a list, delete a list, view the 
call. Save your changes. Select one of your temp lists (File menu, Select List, select 
Owned, select the list). Use the Batch Editor to apply a entry for Personal Short Text 
to the calls.  
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Other Stuff 
 
1. Alert someone 

Use Tools menu, Notifications to bring up the Notifications form. Select the Notify 
tab. Select Alert. Select any calls you want to send with the alert. Select users you 
want the alert to go to by selecting them from the Users box. You must click on the 
user so that they appear in the Send to list. Include yourself to see how alerts work 
(and to do #3). Note: You can remove a user from this list by double clicking. Type 
in the Subject of notification. Click OK. 

 
2. Process an alert 

When you have new alerts the Process Alerts button on the tool bar turns red. Note: 
The icon for NOIS also turns red, so even if your application is minimized, you can 
see the change on your taskbar (also if you'd like a sound to play, see Icons and 
Sounds in the online help). To process alerts, click the Process Alerts button or use 
Tools menu, Process Alerts. The subject of the call will be appended with who sent 
the alert. 

 
3. Remove alerts 

If you receive alerts on calls you don't want to be alerted on, use Tools menu, 
Notifications to bring up the Notifications form. Select the Remove tab. Select the 
calls you don't want to be alerted on. Click OK. You can do this by using View menu, 
Other Information and selecting Notifications. Note: If you are using Notification by 
Affiliation or Active-Update lists to define your notification, you will still be notified 
on calls meeting those criteria. 

 
4. Edit a web page 

Use Tools menu, Edit Web Page to bring up the Edit Web Page form. Enter the 
package. Use the Selection drop-down list to find the web page you wish to edit. The 
information on the web page will be filled in. Edit any portion of the title, problem, 
and solution. Click Save. Review the web page by browsing to it from the Solution 
Index page. 

 
5. Patch Tracking 

Use Tools menu, Profile Information to bring up the Profile Information form. 
Click on the Patch tab. Select a patch and click on the various reports. Click on the 
Location tab. Select a location. Click on the reports that have to do with patches. 
Click on the Module tab. Select a module. Click on the reports related to patches. 

 
6. Package Tracking 

Same as #7 except only look at Location and Module tabs. Look for reports related to 
package installs. 
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Tips 
 
Sign on to NOIS and keep it minimized while you work on other things. Specialists on 
Forum have a four hour timeout. You can still monitor alerts as you work. 
 
Use Notification by Affiliation for all calls for the packages you develop and maintain. 
Using List Manager, enter UD for user defaults. Set the field for Notify by Affiliation to 
Referred. Enter the Package Affiliation multiple with packages you want alerts on. 
 
Use the field Referral Specialist, Patch, Subcomponents, and Keywords to categorize 
calls within your workgroup. You may want to coordinate this with the Customer Service 
team affiliated with the package. 
 
Use the List Organizer to put problems into a group of the same type of problems. Use 
the Duplicate Editor whenever you can match duplicates. Use Personal Fields to further 
categorize calls that you may want to put into a spreadsheet. Use the Batch Editor to 
assign patch numbers, personal fields, and keywords. 
 

Quiz  
 
1) What list would you use? 

a) You processed your alerts but didn't get a chance to review them. 
b) You want to look for some calls your coworker edited. 
c) You need the referred calls for a package. 

 
2) How would you see a distribution of referred calls for your package by location? 
 
3) For the current call, where do you find out? 

a) who last edited it and what was changed 
b) who is automatically being alerted on this call. 

 
4) How do you go back to the calls you were reviewing before you did that selection 

query that found no calls? 
 
5) How would you find out if a site has all the patches for a package installed. 
 
6) How would you find the sites that have installed your test patch. 
 
Answers 
1a. MRA: <yourself>, 1b. MRE: <your coworker, 1c. Package, Referred: <package> 
2. Select Package, Referred: <package> use a Statistic format for Location, or use a Graph format for Location. 
3a. Status History/Audits, 3b. Notifications/List (these are buttons on the display toolbar) 
4. Before doing the query, save the list to your temp list. Then you can return to those calls by doing a refresh list (F5). 
5. Use Profile Information, Module tab, select module, the report Patches Not Installed (at location), and site. Also 
from the Location tab, select site, the report Patches Not Installed (for Module), and module. 
6. Same as #5 but use the report Test Patches Installed. 
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